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OVERVIEW

1.0 Introduction

AutoCAD Civil 3D software provides engineers and his design team with a comprehensive AutoCAD®-based
package for importing and exporting data as well as wide range of site analysis tools. Using an industry-proven,
dynamic engineering model, AutoCAD Civil 3D links design and production drafting, greatly reducing the time
taken to implement design changes and evaluate multiple scenarios. A change made in one place instantly
updates the entire project, helping you complete projects faster, smarter, and more accurately. All team
members work from the same consistent, up-to-date model, so they stay synchronized throughout all project
phases.

2.0 Objectives

This intensive training session is customized to meet the following objectives:-

(a) To expose AutoCAD Civil 3D & myCivil Plus technology and solutions provided by it.
(b) To synergize AutoCAD Civil 3D & myCivil Plus with current engineering workflow.
(c) To ensure end-users are able to kick-start their preliminary design using AutoCAD Civil 3D & myCivil

Plus.
(d) To familiarize users on the workflow of simple road design in AutoCAD Civil 3D & myCivil Plus.

3.0 Training Content Preparation

This training should be accompanied by the following training materials:
(a) Training Courseware (this book).
(b) Training Datasets (one piece DVD) which includes various drawings and data for each exercise.
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CHAPTER 1 : INTRODUCTION TO AutoCAD Civil 3D and myCivil Plus

1.1 AutoCAD Civil 3D Interface and Commands

The user interface of AutoCAD Civil 3D offers a window-based, easy to use and configurable environment.
There are sets of ribbon menus, toolbars, and palettes that are grouped and organized so that users can create
a custom, task-oriented design environment.

Figure 1.1 : Workspace menu drop-down

Use “Workspace” to quickly change the interface of
AutoCAD Civil 3D (Figure 1.1). The application offers a
set of pre-defined workspaces that break down the
user interface into typical design tasks.  We can quickly
switch between these workspaces to have an
environment that is tailored for a certain task or
workflow, such as planning & analysis, 2D drafting and
annotation.

In the example on the left, you can switch the interface
to “2D Drafting & Annotation” if you require to work in
regular AutoCAD interface.

Figure 1.2 : Toolspace panel

“Toolspace” (Figure 1.2).

To activate, Home tab > Toolspace

The Toolspace has several tabs; Prospector, Settings,
Survey and Toolbox.

Prospector : to manage project and drawing objects.

Settings : to manage styles for AutoCAD Civil 3D
objects and to control settings for drawings and
commands.

Survey : to manage survey and system settings as well
as survey data.

Toolbox : to access the Reports Manager and to add
custom tools.

Another important component of the AutoCAD Civil 3D user interface are ribbon tabs and toolbars (Figure 1.3).
AutoCAD Civil 3D offers a ribbon menu for each object that can be created.  It also offers consistent set of
toolbars for the layout and editing objects.

Figure 1.3 : AutoCAD Civil 3D Ribbon Menus and Toolbars
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1.2 myCivil Plus Template

When you first launch AutoCAD Civil 3D, it always define the new drawing by using the “_AutoCAD Civil 3D
(Metric) NCS.dwt” template. There is not much stylization in the default “_AutoCAD Civil 3D (Metric) NCS.dwt”
template.

In order to get more efficient analysis, design and stylization settings, based on local standard, please install
myCivil Plus template included in this manual.

1.2.1 myCivil Plus Installation Guide

This section provides step-by-step procedures to install the myCivil Plus on top of AutoCAD Civil 3D Standalone
license. This document is also applicable to the Clients/Workstations in a Network license environment.

The installation procedures are divided into four (4) stages:
 Stage 1 : Showing Windows Explorer hidden folders and file extensions.
 Stage 2 : Installing the C3D DWT file.
 Stage 3 : Installing the Design Criteria Standards.
 Stage 4 : Installing the Cassini Projection Coordinate Systems.

PRE-REQUISITES BEFORE INSTALLATION:
 Ensure you have login as the Administrator or login as Power Users privileges.
 The steps in this documentation are targeted for Windows 7 operating system and its variants.

Windows XP and 8 operating systems may have different interfaces but the procedures are similar to
the Windows 7.

 RC = "Right-Click" mouse.

STAGE 1 : SHOWING WINDOWS EXPLORER HIDDEN FOLDERS AND FILE EXTENSIONS.

No. Descriptions Commands/Remarks
1.1 Launch "Windows Explorer". RC "Start" > Open Windows Explorer

Or, press “Windows + E”
keyboard to launch Windows Explorer.

1.2 Goto Folder Options. Click Organize > Folder and search options

Note : For Windows XP, goto Tools > Folder Options...
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1.3 Activate the settings as highlighted. Goto "View" tab and change the settings as highlighted
below.

Click "OK" to close the Folder Options dialog box.

STAGE 2 : INSTALLING THE C3D DWT FILE.

No. Descriptions Commands/Remarks
2.1 Copy the Malaysian Template

from the CD directory.

Please note that the
“_AutoCAD Civil 3D 20xx
MALAYSIA yymmdd.dwt”
template is developed as per
intended. Any values presented
in this template must be
verified.

While still in the Windows Explorer application, goto the CD
directory at "../C3D Essentials 20xx/MALAYSIA Template/".

Copy the filename "_AutoCAD Civil 3D 20xx MALAYSIA
yymmdd.dwt".

Note :
xx = the version of myCivil Plus release.
yymmdd = the version of the Malaysian Template in year-month-day
format.

2.2 Launch "AutoCAD Civil 3D 20xx
Metric".

"Start" > All programs > Autodesk > AutoCAD Civil 3D 20xx Metric.

Note : Ensure to launch the "Metric" version as the units will be in
"meter". The "Imperial" version will be having units in "feet" and
"inches".
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2.3 Launch "Options" dialog box. RC on the drawing area > Options...

2.4 Change the QNEW file. Goto "Files" tab > Template Settings > Default Template File Name
for QNEW > highlight the file path > "Browse..." button.

2.5 Paste the template in the
AutoCAD Civil 3D template
directory.

RC anywhere in the list > Paste

2.6 Assigning the template. Highlight the pasted DWT file > Open
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2.7 Verifying the QNEW template
has been successfully assigned.

Ensure the QNEW directory is referring to "..\_Autocad Civil 3D 20xx
malaysia yymmdd.dwt"

Click "OK" to apply the settings.

2.8 Close AutoCAD Civil 3D 20xx
application.

2.9 Re-launch AutoCAD Civil 3D
20xx Metric.

 If required, click "Enable Macros" to accept macros running in
the application.

 If required, click "OK" to accept additional language dialog.

2.10 Double check the template has
been applied appropriately.

Once the blank drawing is opened, goto "Settings" tab > Alignment >
Alignment Styles

You should be able to see "MALAYSIA Alignment" style as depicted
above. If you do not see them, please repeat steps 2.1 previously.

STAGE 3 : INSTALLING THE DESIGN CRITERIA STANDARDS.

No. Descriptions Commands/Remarks
3.1 Copy the Design Criteria

Standards from the CD directory.
Launch back the Windows Explorer application, goto the CD
directory at "../C3D Essentials 20xx/MALAYSIA Template/Design
Criteria Editor".

Copy filenames "__Road Engineering Association of Malaysia
REAM_REVISED.xml" and "Arahan Teknik JKR 8_86_REVISED.xml"
as depicted below.
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3.2 Pasting the XML files. Still in the Windows Explorer, paste both XML files into the
following directory:

For Windows XP,
C:\ Documents and Settings \ All Users \ Application Data \
Autodesk \ C3D 20xx \ enu \ Data \ Corridor Design Standards \
Metric

For Windows 7/8,
C:\ ProgramData \ Autodesk \ C3D 20xx \ enu \ Data \ Corridor
Design Standards \ Metric

STAGE 4 : INSTALLING THE CASSINI PROJECTION COORDINATE SYSTEMS.

No. Descriptions Commands/Remarks
4.1 Copy the coordinate system files

from the CD directory.
Launch back the Windows Explorer application, goto the CD
directory at "../C3D Essentials 20xx/MALAYSIA
Template/Coordinate System".

Copy filenames "Category.CSD" and "Coordsys.CSD" as depicted
below.

4.2 Back-up the default Coordinate
System files.

For Windows XP, browse to:
C:\ Documents and Settings \ All Users \ Application Data \
Autodesk \ Geospatial Coordinate Systems

For Windows 7/8, browse to
C:\ ProgramData \ Autodesk \ Geospatial Coordinate Systems
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4.3 Rename the default Coordinate
System files to .BAK file.

Rename both file extensions from .CSD to .BAK as depicted below.

4.4 Pasting the new Coordinate
System files.

Right-Click on the "Geospatial Coordinate Systems" folder > Paste

4.5 Close myCivil Plus application and
re-launch to begin your project.

That's all. You have now configured myCivil Plus running on top of AutoCAD Civil 3D application. Enjoy the
power of myCivil Plus.

RENAME TO
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CHAPTER 2 : CLEAN-UP THE SURVEY DRAWINGS

Everytime we receive any drawings from any parties, we have to clean-up these drawings before inserting
them into myCivil Plus. This will ensure the drawings are free from malicious and erroneous data that can
affect myCivil Plus performance.

No. Descriptions Commands/Remarks
1. Open the survey / architect

drawing.

Browse to filename “01 Proposed Highway 2013_START.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Check the drawing unit and
scale.

Randomly check the drawing values (e.g. bearing-distance; drainage
width, road width, etc.) so that they are in the correct unit and scale.
myCivil Plus ONLY works in metric unit (i.e. all drawing objects must
be in “meters”).

Use the AutoCAD “DISTANCE” (e.g. “DI”) command to check the unit
of the objects.

If the drawing is not in “meters” unit, please consult your drafting
department on how to convert the drawing appropriately.

4. Refresh opened drawing. “REA”

5. Turn on/thaw/unlock all layers. “LA”. Ensure all layers are turn on, thaw and unlock.

6. Zoom Extents. “ZE”. Remove any erroneous data.

7. Remove unwanted AutoCAD
entities.

“PU” > “Purge All” > “Purge All Items”
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8. Remove unwanted hidden
AutoCAD entities.

“-PU” > “Regapps”
 Enter name(s) to purge = *
 Verify each name to be purged? = N

9. Advanced drawing clean-up. “mapclean” > “Next”

Hit “Next”  > “Finish”
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10. Refresh drawing. “REA”

11. Saving the cleaned drawing. “Save As”. Filename = “02 Proposed Highway 2013_CLEANED.dwg”

If you received pre-com/architect plan separately, please repeat
step 1-8 above.

12. Close myCivil Plus application.
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CHAPTER 3 : CREATING EXISTING/ORIGINAL GROUND SURFACE

There are three (3) methods to create Original Ground Level (OGL) surface, namely:

i. OGL from AutoCAD TEXTS
ii. OGL from AutoCAD POINTS

iii. OGL from AutoCAD COUNTOUR LINES (Recommended)

Users have to choose one from the above. The most accurate surface is generated from COUNTOUR LINES,
followed by AutoCAD POINTS and the least accurate will be from AutoCAD TEXTS. The selection between the
three above is depending on what information is embedded into the Survey drawing and whether these data
can be processed directly or indirectly.

Alternatively, the OGL Surface can be generated from ASCII text file. The text file contains Easting, Northing
and Elevations of all the points. Refer to “C3D10 - Generic Demo.avi” video for more details.

myCivil Plus can also convert GIS (e.g. MapInfo tab file, etc.) and GPS (e.g. Garmin ASCII text file, etc.) data to
create OGL surface. Refer to “GIS to DWG.avi” video for more details.

3.1 Creating OGL Surface from AutoCAD TEXTS (OPTION 1)

No. Descriptions Commands/Remarks
1. Launch AutoCAD Civil 3D Metric

and ensure the Malaysia
Template is applied.

"Settings" tab > Alignment > Alignment Styles

If the settings above is not available, please refer to CHAPTER 1 –
Section 1.2.1 “mycivil Plus Installation Guide”

2. Insert the cleaned survey /
architect drawings.

Type “Insert” in command line > browse to the CLEANED drawing.
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3. "Zoom Extents" and refresh the
inserted drawing.

“ZE” & “RE”.

4. Displaying only survey spot
levels.

Select any spot level text > RC > “Select similar” > RC > “Isolate
Objects” > “Isolate Selected Objects”.

5. Filtering only numerical text
points (eg. Ground elevations,
invert levels, manholes depth,
etc.)

RC > “Quick Select”

RC > “Isolate Objects” > “Isolate Selected Objects”

6. Creating two new layers; ie.
“HEIGHT” & “HEIGHT-IL”.

Note : This step is OPTIONAL.

“LA”

7. Assigning layer to elevations.

Note : This step is OPTIONAL

 Select all text points.

 Change layer name to “HEIGHT”.

8. Selecting miscellaneous
elevations (eg. invert levels,
manholes depth, etc.)

Note : This step is OPTIONAL

 RC > “Quick Select”.
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 Change the selected text object layer name to “HEIGHT-IL”.

9. Find and Replace “IL” with
number “000”.

Note : This step is OPTIONAL

RC > “Find…”

Click “Replace All”.

You may need to repeat these steps for "MH", "LP", etc. separately.

10. Converting 2D text points to 3D
text points.

“Modify” tab > “Surface” > “Surface Tools” > “Move Text to
Elevation” > select all 3D text points > ENTER.

11. Creating Original Ground Level
(aka OGL) surface.

 Prospector > RC “Surfaces” > “Create Surface…”
 Name = “OGL from TEXT”
 Leave other default values > OK

12. Prospector tab > OGL from TEXT > Definition > RC “Drawing Objects” > Add...

> >   Select all 3D text points > ENTER
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13. Refresh drawing. “REA”

14. Viewing OGL surface in 3D
mode.

Select the surface contours > RC > “Object Viewer”

15. If in 3D viewing mode, the model is completed without erroneous data, proceed to next step. Else,
investigate the erroneous data and rectify them.

16. Ending the isolate object mode. RC > “Isolate Objects” > “End Object Isolation”

17. Zoom Extents & Refresh
drawing.

 “ZE”
 “REA”

18. Saving drawing. “Save As” filename “03 Proposed Highway 2013_OGL from
TEXT.dwg”

19. Improving the OGL surface to
emphasize existing culverts,
berms, monsoon drain, etc.

In the drawing area, select any culvert line > RC > Select similar

20. Adding breaklines to the OGL
surface.

Prospector tab > Surfaces > OGL from TEXT > Definition > RC
Breaklines > Add...

21. Assigning Proximity Breaklines. Change the Breaklines type to "Proximity" > OK.

22. Viewing OGL surface in 3D
mode.

Select the surface contours > RC > “Object Viewer”

23. If in 3D viewing mode, the model is completed without erroneous data, proceed to save the drawing.
Else, investigate the erroneous data and rectify them.
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24. Saving drawing. “Save”.

25. Close the drawing and
application.
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3.2 Creating OGL Surface from AutoCAD POINTS (OPTION 2)

No. Descriptions Commands/Remarks
1. Launch AutoCAD Civil 3D Metric

and ensure the Malaysia
Template is applied.

"Settings" tab > Alignment > Alignment Styles

If the settings above is not available, please refer to CHAPTER 1 –
Section 1.2.1 “myCivil Plus Installation Guide”

2. Insert the cleaned survey /
architect drawings.

Type “Insert” in command line > browse to the CLEANED drawing.

3. "Zoom Extents" and refresh the
inserted drawing.

“ZE” & “RE”.

4. Selecting all AutoCAD points. RC > “Quick Select”.
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5. Displaying only survey spot
levels.

While all the points are selected > RC > “Select similar” > RC >
“Isolate Objects” > “Isolate Selected Objects”.

6. Creating Original Ground Level
(aka OGL) surface.

 Prospector > RC “Surfaces” > “Create Surface…”
 Name = “OGL from POINT”
 Leave other default values > OK

7. Prospector tab > OGL from POINT > Definition > RC “Drawing Objects” > Add...

> >   Select all points > ENTER

8. Clean the progress report. Action > Clear All Events > Close

9. Refresh drawing. “REA”

10. Viewing OGL surface in 3D
mode.

Select the surface contours > RC > “Object Viewer”

11. If in 3D viewing mode, the model is completed without erroneous data, proceed to next step. Else,
investigate the erroneous data and rectify them.

12. Ending the isolate object mode. RC > “Isolate Objects” > “End Object Isolation”
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13. Zoom Extents & Refresh
drawing.

 “ZE”
 “REA”

14. Saving drawing. “Save As” filename “03 Proposed Highway 2013_OGL from
POINT.dwg”

15. Improving the OGL surface to
emphasize existing culverts,
berms, monsoon drain, etc.

In the drawing area, select any culvert line > RC > Select similar

16. Adding breaklines to the OGL
surface.

Prospector tab > Surfaces > OGL from TEXT > Definition > RC
Breaklines > Add...

17. Assigning Proximity Breaklines. Change the Breaklines type to "Proximity" > OK.

18. Clean the progress report. Action > Clear All Events > Close

19. Viewing OGL surface in 3D
mode.

Select the surface contours > RC > “Object Viewer”

20. If in 3D viewing mode, the model is completed without erroneous data, proceed to save the drawing.
Else, investigate the erroneous data and rectify them.
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21. Saving drawing. “Save”.

22. Close the drawing and
application.
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3.3 Creating OGL Surface from COUNTOUR LINES (OPTION 3)

No. Descriptions Commands/Remarks
1. Launch AutoCAD Civil 3D Metric

and ensure the Malaysia
Template is applied.

"Settings" tab > Alignment > Alignment Styles

If the settings above is not available, please refer to CHAPTER 1 –
Section 1.2.1 “mycivil Plus Installation Guide”

2. Insert the cleaned survey /
architect drawings.

Type “Insert” in command line > browse to the CLEANED drawing.

3. "Zoom Extents" & refresh the
inserted drawing.

“ZE” & “RE”.

4. Select all contour lines. Select any AutoCAD contours > RC > “Select similar” > RC > “Isolate
Objects” > “Isolate Selected Objects”.

5. Creating Original Ground Level
(aka OGL) surface.

 Prospector > RC “Surfaces” > “Create Surface…”
 Name = “OGL from CONTOUR”
 Leave other default values > OK

6. Prospector tab > OGL from CONTOUR > Definition > RC “Contours” > Add...
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> >   Select all contours > ENTER

7. Clean the progress report. Action > Clear All Events > Close

8. Refresh drawing. “REA”

9. Viewing OGL surface in 3D
mode.

Select the surface contours > RC > “Object Viewer”

10. If in 3D viewing mode, the model is completed without erroneous data, proceed to next step. Else,
investigate the erroneous data and rectify them.

11. Ending the isolate object mode. RC > “Isolate Objects” > “End Object Isolation”

12. Zoom Extents & Refresh
drawing.

 “ZE”
 “REA”

13. Saving drawing. “Save As” filename “03 Proposed Highway 2013_OGL from
CONTOUR.dwg”

14. Close the drawing and
application.

All three surfaces have been created in separate drawings. We shall continue with filename “03 Proposed
Highway 2013_OGL from POINT.dwg” because the provided contour lines are not covering the whole corridor
properly.
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CHAPTER 4 : myCIVIL PLUS ANALYSIS

Once we have created the OGL surface, we shall investigate the site for drainage planning and allocating
proposed alignments.

myCivil Plus comes with pre-defined analysis functions. The analyses included are contours, directions,
elevations, slopes, slope-arrows, user-defined contours, watersheds and water drops.

4.1 Contour Labeling

No. Descriptions Commands/Remarks
1. Open the OGL Surface drawing.

Browse to filename “03 Proposed Highway 2013_OGL from
POINT.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Check the drawing unit and
scale.

Randomly check the drawing values (e.g. bearing-distance; drainage
width, road width, etc.) so that they are in the correct unit and scale.
myCivil Plus ONLY works in metric unit (i.e. all drawing objects must
be in “meters”).

Use the AutoCAD “DISTANCE” (e.g. “DI”) command to check the unit
of the objects.

If the drawing is not in “meters” unit, please consult your drafting
department on how to convert the drawing appropriately.

4. Labeling the contour lines. Annotate tab > Add Labels > Surface > Contour - Multiple

5. Placing the label on the drawing. Ensure OSNAP is off.
Click any two points crossing the OGL surface contours.
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4.2 Elevation Analysis

Usage : To determine the different height/elevation in the project area.

No. Descriptions Commands/Remarks
1. Goto OGL Surface Properties. +Surfaces > RC “OGL from POINT” > Surface Properties...

2. Running and applying the
Elevation analysis onto OGL
surface.

Note :
 Double-Click (DC) to change

the values for Minimum
Elevation and Maximum
Elevation.

 DC to change the Color
Scheme.
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3. Applying the Elevation Banding
(2D) styles

4. Generating the Legend of
Elevation Analysis.

5. Put the mouse cursor in the
drawing & select “Elevations”.

6. Select “Dynamic” behavior.
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7. Click at any empty space in the
drawing.

4.3 Slope Arrows Analysis

Usage : To determine the natural/gravitational flow of surface runoff.

No. Descriptions Commands/Remarks
1. Goto OGL Surface Properties. +Surfaces > RC “OGL from POINT” > Surface Properties...

2. Running and applying the Slope
Arrows analysis onto OGL
surface.

Note :
 Double-Click (DC) to change

the values for Minimum
Slope and Maximum Slope.

 DC to change the Color
Scheme.
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3. Applying the Slope Arrow
Banding (2D) styles

4. Generating the Legend of Slope
Arrow Analysis.

5. Put the mouse cursor in the
drawing & select “slopeArrows”.

6. Select “Dynamic” behavior.
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7. Click at any empty space in the
drawing.

8. Regenerate the drawing. “REA”

9. Perform Water Drop analysis.
(Optional).

10. Select “OK”.

11. Click continuously at any high
points / peak of any
hills/mountains.

Note: If the Water Drop lines do
not appear, run “REA”
command.

12. The Water Drop Analysis explains the potential water/surface run-off path for that particular surface.
Hence, we can estimate the potential water collection point for that surface/site.

13. Zoom Extents & Refresh
drawing.

 “ZE”
 “REA”

14. Saving drawing. “Save As” filename “04 Proposed Highway 2013_Analysis.dwg”.

15. Close the drawing and application.
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CHAPTER 5 : ALIGNMENT DESIGN

This chapter will demonstrate step-by-step approach to :
 Creating Horizontal Alignment
 Editing Horizontal Alignment
 Labelling Alignment Control Plan

5.1 Creating Horizontal Alignment

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “05 Proposed Highway 2013_Alignment.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Simplify the model space. Select the following objects in the drawing area:
 OGL Surface,
 ARS 5 text, leader line and circle indicator.
 Any spot level text.

4. Isolate the objects. RC > Select Similar > RC > Isolate Objects > Isolate Selected Objects

5. Run “Alignment Creation Tools”
command.
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6. Give a dedicated name for the
alignment, say “PROPOSED”.

Select “Design Criteria” tab.

7.  Enter design speed (say
70km/h).

 Activate “Use criteria-based
design”.

 Activate “Use design criteria
file”.

 Select the appropriate
Attainment Method.

 Uncheck “Use design check
set”.

8. Ensure OSNAP is set to CENTER
only.

9. Click the drop-down icon > run
“Tangent-Tangent (With curves).

10. Zoom and OSNAP-click at ARS 5.
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11. Zoom and OSNAP-click at ARS 9

12. Zoom and OSNAP-click at ARS 13

13.  Hit ENTER keyboard.
 Close the Alignment toolbar.

14. Close the drawing without
saving.

5.2 Editing Horizontal Alignment

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “06 Proposed Highway 2013_Alignment
Editing.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Adding IP points.
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In the command line, enter the followings:

IP 1 : N = 517 47 00; E = 219 33 77
IP 2 : N = 517 46 11; E = 219 36 44

4. Terminate the command. Hit ESCAPE keyboard twice. Close the “Create Point” toolbar.

5. Select the alignment in the
drawing.

Ensure OSNAP is set to “Node”.

6. Run “Geometry Editor”
command.

7. Select “Insert PI” icon.

8. Selecting desired IPs.  Click at both nodes of IP 1 and IP 2.
 Hit ESCAPE keyboard twice to end the command.

9. Adding circular curve at IP 1.  Zoom to IP 1 area.
 Run the “Free Curve Fillet” command.
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 Click tangent line BEFORE IP 1.
 Click tangent line AFTER IP 1.
 Solution angle = Lessthan180.
 Radius = 170
 ESCAPE keyboard twice to end command.
 A warning symbol will appear at IP 1 as shown below.

We shall remedy this later.

10. Adding transition spiral and
circular curve at IP 2.

 Zoom to IP 2 area.
 Run the “Free Spiral-Curve-Spiral” command.

 Click tangent line BEFORE IP 2.
 Click tangent line AFTER IP 2.
 Solution angle = Lessthan180.
 Radius = 195
 Spiral-in length = 39
 Spiral-out length = 39
 ESCAPE keyboard twice to end command.
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11. Return back to IP 1 in order to
rectify the alignment warning
symbol.

 Zoom to IP 1 area.
 Run the “Alignment Grid View” command.

 Notice the warning symbol for violating “Minimum Radius” at
70km/hr design speed. Therefore, Double-Click the 170m radius
value.

 Change the value to “195”, and the warning symbol will dismiss.

12. Adjusting other values.  Change the second circular radius to 500.

13. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

14. Close the drawing. Do not save.

5.3 Alignment Labelling : Control Plan

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “07 Proposed Highway 2013_Alignment Control
Plan.dwg”
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2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Labelling Circular Curve Control
Plan

4.  Label type =
Point of Intersection

 Label style =
MALAYSIA – IP Curve

5. Select the desired IP that has
Circular Curves ONLY.

 Click at blue-colour Circular Curves at IP 1 and IP 3.
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6. Label style =
MALAYSIA – IP T-S-C

7. Select the desired IP that has
Transition Curves ONLY.

Click at blue-colour Transition Curve at IP 2.

8. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

9. Close the drawing. Do not save.

5.4 Alignment Labelling : Fixed Interval Coordinates

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “07 Proposed Highway 2013_Alignment Control
Plan.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.
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3. Goto “Home” tab > Points >
Create Points – Alignments >
Measure Alignment.

4. Command line prompts “Select
Alignment”. Just click the
alignment in the model space.

5. Command line prompts “Starting
station <0.000>”. Just ENTER
keyboard.

6. Command line prompts “Ending
station <1227.286>”. Key in the
round-down value of the end
chainage. In this example, we
will round-down to 1220. So,
type in “1220” and hit ENTER.

7. Command line prompts “Specify
an offset <0.000>”. Just hit
ENTER keyboard.

8. Command line prompts “Enter
an interval <10.000>”. Type in
your desired value. In this
example, we will type in “20”
and hit ENTER.

9. Command line prompts “Select
Alignment”. Just hit ESCAPE
keyboard to end the command.
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10. You may close the “Create
Points” dialog box.

The points are now shown along
the alignment.

Next is to resize the points and
label them accordingly.

11. “Prospector” tab > Points
Groups > RC “_All Points” >
Properties…

12. Information tab > Edit Current
Selection.

13.  Goto “Marker” tab.
 Verify the highlighted value.
 Click OK.
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14. Back to “Information” tab,
change the Point label style to
“Northing and Easting”, and click
OK.

15. The alignment now is labelled
with fixed interval CoGo points
having Northing and Easting
coordinates.

16. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

17. Close the drawing. Do not save.
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CHAPTER 6 : SUPERELEVATION DESIGN

This chapter will demonstrate step-by-step approach to design superelevation for circular curves and transition
curves.

6.1 Creating Superelevation

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “08 Proposed Highway
2013_Superelevation.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Select the desired alignment. Click the alignment.

4. Run the “Calculate/Edit
Superelevation” command.

5. Run the “Calculate
superelevation now”.
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6.  Select the desired Roadway
Type

 Click “Next”.

7.  Normal lane width = 3.75m
 Normal lane slope = -2.5%
 Click “Next”.

8.  Setup the desired shoulder
parameters.

 Click “Next”.
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9.  Setup the desired
attainment parameters.

 Click “Finish”.

10. Scroll up-down and left-right to
see all calculated Superelevation
values. You may change the
values by Double-Click the cells.

 Close the Superlevation table.

11. The Superelevation wedges are
printed along the alignment.

12. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

13. Close the drawing. Do not save.
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CHAPTER 7 : PROFILE DESIGN

Profile is also known as Longitudinal Section. This chapter will demonstrate step-by-step approach to :
 Creating OGL profile.
 Generating PROPOSED profile.
 Editing PROPOSED profile.

7.1 Creating Profile

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “09 Proposed Highway 2013_Profile.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Select the alignment. Run the “Surface Profile” command.

4.  Surfaces = OGL
 Click “Add>>” button
 Click “Draw in profile view”

button.
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5. In General parameters, just hit
“Next>”.

6. In Station Range parameters,
just hit “Next>”.

7. In Profile View Height
parameters, just hit “Next>”.
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8. In Profile Display Options
parameters, just hit “Next>”.

9. In Data Bands parameters:
 Band set = MALAYSIA Profile

Band Set.
 “Next>”.

Note:
If the MALAYSIA Profile Band Set
is not available, please refer to
CHAPTER 1, Section 1.2.1 of this
Manual.

10. In Profile Hatch Options
parameters, hit “Create Profile
View” button.
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11.  Ensure OSNAP is set to
“Center” ONLY.

 Click at the “Profile 0,0
Coordinate” marker.

Note :
You can place the Profile
anywhere in the drawing.

12. A Profile View is drawn
accordingly.

13. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

14. Close the drawing. Do not save.

7.2 Generating PROPOSED Profile

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “10 Proposed Highway 2013_PROPOSED
Profile.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Home tab > Profile > Profile
Creation Tools.
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4. Click the Title of the Profile View.

5.  Give a unique name for the
PROPOSED profile.

 Click “Design Criteria” tab.

6.  Activate “Use criteria-based
design”

 Activate “Use design criteria
file”

 Un-check “Use design check
set”

 Hit “OK”.

7. Run the “Curve Settings…”
command.
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8.  Enter the required
parameters.

 Hit “OK”.

9. Run the “Draw Tangents With
Curves” command.

10.  Zoom to the Profile View.
 Ensure OSNAP is set to

“CENTER”.
 Click at VIP 1, then, VIP 2,

and finally VIP 3.

11. ESCAPE keyboard to end the
command.

12. Select the title of the Profile
View.

13. Run the “Profile View
Properties” command.
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14. Change the settings as shown below:

15. The Profile View is updated. Hit ESCAPE keyboard to end the command.

16. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

17. Close the drawing. Do not save.

7.3 Editing PROPOSED Profile

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “11 Proposed Highway 2013_Profile
Editing.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.



myCivil Plus 2016 : Intensive Training for Beginners Road & Highway Module

autobimnetwork@gmail.com 49 of 87

3.  Zoom to VIP 3.
 Click the PROPOSED profile

line.

4.  Click the square-cyan-grip.

5.  Ensure OSNAP is set to
“ENDPOINT” ONLY.

 OSNAP at the end of OGL
Profile line.

 Hit ESCAPE to end the
command.

6.  Select the PROPOSED Profile
line.

 Run the “Geometry Editor”
command.

7. Select the “Profile Grid View”
icon.

8. Double-Click the K-value that is
violated.

9.  Change K-value to “200”.
 The warning symbol is

dismissed.

10. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

11. Close the drawing. Do not save.
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CHAPTER 8 : ASSEMBLY DESIGN

Assembly is also known as Typical section/detailing of the road. This chapter will demonstrate step-by-step
approach to :
 Creating Assembly from various sub-assembly objects.

8.1 Creating Assembly

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “12 Proposed Highway 2013_Assembly.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Home tab > “Properties”
icon.

4. Click the “black-cabinet” icon.

5. Select “Anchor Right >”
command.

The “Properties” panel will be
placed at the right-side of the
screen.

Just touch the “Properties” bar
and it will auto-slide.
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6. Goto Home tab > “Tool Palettes”
icon.

7. Click the “black-cabinet” icon.

8. Select “Anchor Right >”
command.

The “Tool Palettes” panel will be
placed at the right-side of the
screen.

Just touch the “Tool Palettes”
bar and it will auto-slide.

9. Zoom to the “Place Assembly
here” area.

Note:
You can place the assembly
anywhere in the drawing.

10. Home tab > Assembly > Create
Assembly
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11. Set the “Name” and “Assembly
Type”.

12. Click anywhere in the provided
box.

Note:
You can place the assembly
anywhere in the drawing.

13. Tool Palettes > Lanes tab >
“LaneSuperelevationAOR”.

14. In the Properties slider-panel,
change the required parameters.
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15. Click the “Assembly” object and
the first lane on the right-side
will be generated.

16. In the Properties slider-panel,
change the required parameters
as highlighted.

17. Click the “Assembly” object and
the opposite lane on the left-
side will be generated

18. Tool Palettes > Shoulders tab >
“ShoulderExtendSubbase”.
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19. In the Properties slider-panel,
change the required parameters
as highlighted.

20. Click at the RED circle on the
right-side lane.

21. The right-side shoulder will be
generated.

22. Immediately, in the Properties
slider-panel, change the
required parameters as
highlighted.

23. Click at the RED circle on the
left-side lane.
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24. The left-side shoulder will be
generated.

25. Tool Palettes > Trenches tab >
“Ditch”.

26. Immediately, in the Properties
slider-panel, change the
required parameters as
highlighted.

27. Click at the ORANGE circle on
the right-side shoulder.

28. The right-side ditch will be
generated.
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29. Immediately, in the Properties
slider-panel, change the
required parameters as
highlighted.

30. Click at the ORANGE circle on
the left-side shoulder.

31. The left-side ditch will be
generated.

32. Tool Palettes > Daylight tab >
“DaylightBench”.

33. Immediately, in the Properties
slider-panel, change the
required parameters as
highlighted.
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34. Click at the GREY circle on the
right-side ditch.

35. The right-side daylight will be
generated.

36. Immediately, in the Properties
slider-panel, change the
required parameters as
highlighted.

37. Click at the GREY circle on the
left-side ditch

38. The left-side daylight will be
generated.

39. Hit ESCAPE keyboard to end the
command.

40. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

41. Close the drawing. Do not save.
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CHAPTER 9 : CORRIDOR DESIGN

Corridor will combine alignment, proposed profile and assembly to generate 3D road model. This chapter will
demonstrate step-by-step approach to :
 Creating Corridor from alignment, proposed profile and typical assembly.

9.1 Creating Corridor

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “13 Proposed Highway 2013_Corridor.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Home tab > Corridor
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4. Update the highlighted
parameters.

5. Verify the parameters > OK .

6. Select the “Rebuild the corridor”
command.

7. Note:
If you received warning report, please check that the corridor is NOT generated beyond the OGL surface.
The warning is due to insufficient OGL surface to generate the slopes/daylight along the corridor. To
solve this problem, you may need to:
 Enlarge the OGL surface by adding more survey data (RECOMMENDED), or
 Adjust the alignment.

If the alignment is adjusted, please ensure to re-design/update the followings:
 Superelevation
 Proposed profile
 Corridor Parameters (in Corridor Properties command).
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8. The complete corridor is
generated.

9. Prospector tab > Corridors > RC
“PROPOSED” > Properties…

10. Surfaces tab > Create a corridor
surface

11. Change the “Overhang
Correction” to “Bottom Links”.

12.  Specify code = Datum.
 Hit the PLUS symbol icon.

13. The “Datum” links code will be
placed under PROPOSED – (1)
corridor surface data.
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14. Goto “Boundaries” tab.

15. Right-click ”PROPOSED – (1)” >
Corridor extents as outer
boundary”.

16. The corridor surface boundary is
generated.

17. Goto “Slope Patterns” tab > Add
slope pattern

18. Click at the YELLOW ditch line.

19. Click at the PEACH-colour berm
line.

Click the PEACH-colour berm line
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20.  The first Index will be
generated.

 Click OK.

Note:
You may need to adjust the “Station Start” and “Station End”
column values for all other Indexes depending on the location of cut
and fill areas along the corridor.

21. Select “Rebuild the corridor”
command.

22. The “tadpoles” slope pattern is
generated along the benching.

23. Finally, verify the corridor
surface [ie. PROPOSED – (1)] has
been generated as highlighted.

24. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

25. Close the drawing. Do not save.



myCivil Plus 2016 : Intensive Training for Beginners Road & Highway Module

autobimnetwork@gmail.com 63 of 87

CHAPTER 10 : SAMPLE LINES

Sample Lines is used to generate volume calculation (based on Average End Area method) as well as
preparation for Cross-Section drawings. This chapter will demonstrate step-by-step approach to :
 Creating Sample Lines along the proposed corridor.

10.1 Creating Sample Lines

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “14 Proposed Highway 2013_Sample Lines.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Home tab > Sample Lines

4. Hit ENTER keyboard.

5.  Select the desired
alignment.

 Hit “OK”.
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6.  Change the “Style” column
values as highlighted.

 Hit “OK”.

7. Click the drop-down icon and
run “By range of stations…”
command.

8. For LEFT Swath Width,
 Click the “50.000m” value.
 Click the GREEN-colour

cube.

Note:
Pay attention on the direction of
the alignment. The LEFT and
RIGHT swath width is depending
on the direction of alignment.

9. Turn OFF OSNAP setting.

10. Zoom at the WIDEST corridor
area.
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11. Click near the alignment.

12. Click near the daylight area.

13. Round-up the Width value. For
this case, the rounded value is
“30”.

14. Repeat steps “ 8 “ to “ 13 “ for
RIGHT Swath Width value.
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15.  Change the Sampling
Increments value to desired
intervals.

Note :
This value will be used for
volume calculation (based on
Average End Area Method) and
generating cross-section
detailing.

 Hit “OK”.

16.  Place the mouse cursor in
the drawing area.

 Hit ENTER keyboard.

 The Sample Lines is
generated.

17. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

18. Close the drawing. Do not save.



myCivil Plus 2016 : Intensive Training for Beginners Road & Highway Module

autobimnetwork@gmail.com 67 of 87

CHAPTER 11 : VOLUME  CALCULATION

This chapter will demonstrate step-by-step approach to Generate Volume Calculation based on:
 Cross-section Method (a.k.a. Average End Area Method).
 TIN Volume Surface Method.

11.1 Cross-Section Method

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “15 Proposed Highway 2013_Volume.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Analyze tab > Compute
Materials.

4.  Select the desired
Alignment and Sample Line
Group.

 Hit “OK”.
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5.  Change the Object Name
values as per highlighted.

 Hit “OK”.

6. Goto Analyze tab > Volume
Report.

7. Just hit “OK”.

8. Hit “Yes”.
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9. The Volume Report will be
generated in Internet Explorer
application.

You may need to copy-paste into
Microsoft Word or Excel to
produce proper volume report
format.

11.2 TIN Volume Surface Method

No. Descriptions Commands/Remarks
1. Goto Analyze tab > Volumes

Dashboard

2. Run the “Create new volume
surface” command.

3.  Change the values as
highlighted.

 Hit “OK”.
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4.

The TIN volume result is presented in Panorama floating window.

5. Run the “Generate Cut/Fill
report” command.

6.

The Cut/Fill Report will be generated in Internet Explorer application.

7. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

8. Close the drawing. Do not save.
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CHAPTER 12 : CROSS-SECTION DETAILING

This chapter will demonstrate step-by-step approach to :
 Auto-generate cross-section detailing at certain intervals.

12.1 Creating Multiple Cross-Sections

No. Descriptions Commands/Remarks
1. Open the drawing or continue

from previous drawing.

Browse to filename “16 Proposed Highway 2013_Cross Section.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Home tab > Section Views > Create Multiple Views

4. Click “Next”.
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5. Click “Next”.

6. Click “Next”.

7. Click “Next”.
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8. Ensure the section names and
styles as displayed. Click “Next”.

9. Ensure the “Surface1” and
“Surface2” columns as displayed.
Click “Next”.

Note:
If you do not see “PROPOSED”
data, please delete the sample
lines and re-create sample lines
again.

10.  Click “Add>>” button.
 Click “Create Section

Views”.
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11.

12. A sample of Cross Section Views.
We shall improve the Finished
Level and Offset bands to reduce
data.

13. Select any Section View.

14. On the ribbon menu, select
“View Group Properties”.
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15. Goto “Section Views” tab >
under “Change Band Set”
column, click the ellipse button.

16. Change the “Weeding” column as displayed:

Note : You may try bigger or smaller value to adjust the weeding parameter.

17. Click “OK” all the way.

18. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

19. Close the drawing. Do not save.
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CHAPTER 13 : PLAN PRODUCTION

This chapter will demonstrate step-by-step approach to :
 Create construction plans.

13.1 Creating Multiple View Frames and Sheets

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “18 Proposed Highway 2013_Plotting.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Goto Output tab > Create View Frames

4. Hit “Next” button.
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5. Click the “ellipsis” button.

6. Click the “ellipsis” button, again.

7. Browse to the “..\C3D Essentials
20xx \ 03 INTENSIVE
COURSEWARE \ ROAD WATER
WASTEWATER” folder, and select
the “Civil 3D 20xx JKR Plan and
Profile.dwt” template.

Then, hit the “Open” button.

8. Ensure to select “Plan and Profile
1 to 1000” setting.

Then, hit “OK”.

9. Click “Next”.
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10. Label location = “Top center”.

Then, hit “Next”.

11.  Set the “Allow additional
distance for repositioning” to
3.000m

 Left label location = Middle
 Right label location = Middle
 Hit “Next” button.

12. Click “Create View Frames”
button.
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13. You should see three
borders/view frames along the
corridor.

14. Goto Output tab > Create Sheets

15.  Layout Creation = All layouts
in the current drawing

 The north arrow = North
 Hit “Next” button.

16. Hit “Next” button.
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17. Select the “Profile View Wizard…”
button.

18. Hit “Next”.

19. Hit “Next”.
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20.  Change the “Profile1” and
“Profile2” columns as shown.

 Hit “Next” button.

21. Hit “Next”.

22. Hit “Finish”.
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23. Click “Create Sheets”.

24. Hit “OK”.

25. The command line will prompt,
“Select profile view origin:”.

26. Just select anywhere in the model
space (find an empty spot).

27. Two floating windows will appear.
Just close the Event Viewer
report.

28. Near the command line, there will
be a row of Sheet sets. Click any
of the tab to reveal the Plan and
Profile layout ready to be plotted.
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29.

30. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

31. Close the drawing. Do not save.
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CHAPTER 14 : PRINT-OUT REPORTS

This chapter will demonstrate step-by-step approach to :
 Prepare print-out reports for proposed alignment and profile.

14.1 Generating Built-in Technical Report

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “19 Proposed Highway 2013_Reporting.dwg”

2. Ignore “VBA – Not Installed”
message. Select “Continue with
the current command”.

3. Activate the “Toolbox” tab.

4. Right-click “Alignment_Curve” >
“Execute…”
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5. Hit “OK”.

6.  Assign a name for the report.
 Hit “Save”.

7. The default web browser will
present the Alignment Curve
report.

8. Right-click “PVI Station and Curve
Report” > “Execute…”
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9.  Select the alignment.
 Hit the “Create Report”

button.

10. The default web browser will
present the Alignment Curve
report.

11. You may proceed with other
reports listed in the Toolbox tab.

12. Close all windows, Zoom Extents
and regenerate the drawing.

“ZE” & “REA”.

13. Close the drawing. Do not save.
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Disclaimer:
THE AUTHOR MAKES NO WARRANTY, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, REGARDING THESE
MATERIALS AND MAKES SUCH MATERIALS AVAILABLE SOLELY ON AN “AS-IS” BASIS.
IN NO EVENT SHALL THE AUTHOR BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF THESE
MATERIALS. THE SOLE AND EXCLUSIVE LIABILITY TO AUTODESK, INC., REGARDLESS OF THE FORM OF ACTION,
SHALL NOT EXCEED THE PURCHASE PRICE OF THE MATERIALS DESCRIBED HEREIN.
The Author reserves the right to revise and improve its products as it sees fit. This publication describes the
state of this product at the time of its publication, and may not reflect the product at all times in the future

Author’s Note : Should you find any errors or misleading information within this customized courseware,
please send your email to autobimnetwork@gmail.com.

Thank you.
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CHAPTER 7 : GRAVITY PIPE NETWORKS

In this chapter, we will look at modelling only. Model what? Model the pipe network for gravity-based
systems. This kind of system is suitable for underground stormwater and sanitary sewer/sewerage layout.

There are two components which define a complete gravity-based pipe network, i.e. Structures and Pipes.

Structures = manholes, catch basins, inlets, joints and outlets. You may create your own Structures by using
the Part Builder tool in Civil 3D.

Pipes = any type of conduit such as culverts, gas lines, or utility cables. They can be straight or curved. They can
be adapted for water reticulation system too.

First, we will look at the workflow needed to model effective gravitational pipe networks. They are:
 Part Rules.
 Part Lists.
 Creating an underground Storm Drainage/Sanitary Sewer Network.
 Creating a Pipe Network.
 Editing the Pipe Network layout.
 Creating an Alignment from Network Parts.
 Drawing Parts in Profile View.
 Adding Pipe Network Labels
 Running the Interference/Clash Check.

7.1 Part Rules and Part Lists

Every project will have local authority standard/requirements to control the limit/allowance of the proposed
gravitational pipe design – things like minimum slope, sump depths, and pipe-invert drop across structure.

Depending on the type of network (stormwater or sewerage) and the complexity of the design, there are many
different constraints on your design. Civil 3D allows you to establish structure and pipe rules that will assist in
respecting these constraints during initial layout and edits.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “31 Civil 3D Template_Rules_METRIC.dwg”

2. Activate “Settings” tab >
Structure > RC Structure Rule Set
> New…
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3. Name = Sanitary Structure Rules.

4. Goto “Rules” tab > Add Rule…

5. Rule name = Pipe Drop Across
Structure.

Click “OK”.

6. Set the limit as highlighted. These
parameters establish a rule that
will match your hypothetical
municipality’s standard (eg.
Jabatan Perparitan &
Pembetungan).

7. Goto “Rules” tab > Add Rule…

8. Rule name = Set Sump Depth.

Click “OK”.

9. Set the limit as highlighted. These
parameters establish a rule that
will match your hypothetical
municipality’s standard (eg.
Jabatan Perparitan &
Pembetungan).

Click “OK”.

10. Activate “Settings” tab > Pipe >
RC Pipe Rule Set > New…
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11. Let’s name it as “200mm Sanitary
Pipe Rule”.

12. Goto “Rules” tab > Add Rule…

13. Select “Cover and Slope” > OK

14. Set the limit as highlighted. These
parameters establish a rule that
will match your hypothetical
municipality’s standard (eg.
Jabatan Perparitan &
Pembetungan).

Click “OK”.
15. Right-click the newly created rule

set > Copy…

16. Rename as shown.

17. Update the values as shown > OK.

18. Repeat steps 15 to 17 to generate
another pipe rule 300mm as
shown.

Click “OK” when done.
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19. You should now have 1 rule for
Structure and 3 rules for pipe as
shown.

20. The next step is to define the Part Lists. The Part Lists should reside in the Civil 3D template (.DWT).
There is quite a bit of setup involved, and having this information in your .DWT file will ensure you do it
only once.

21. Settings tab > Pipe Network > RC
Parts Lists > Create Parts List…

22. Name it as shown.

23. Pipes tab > RC New Parts List >
Add part family…

The Part Catalog dialog will
appear.

24. Let’s assign “PVC Pipe SI” material
for our Sanitary Sewerage
Network.

Click “OK”.

25. RC “PVC Pipe SI” > Add part
size…”.
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26. Update the highlighted values >
OK.

For “Material”, you may type in
your own material name. But the
engineering properties is not
available in Civil 3D. E.g. “Fibre-
glass”; no engineering properties
of fibre-glass is available in
calculations later.

27. Repeat Steps 25 and 26 to
generate for 250mm and 300mm
pipes as shown.

28. Click the “disk” icon in the Style
column.

29. Let’s assign “Single Line
(Sanitary)” style. Click “OK”.

30. Now, all three diameters will use
the same style in the drawing
later.

31. Assign each diameter following
their respective Rules as shown.

32. Activate the “Structures” tab.

Note:
Null structures are needed when
two pipes are joined together
without a structure.
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33. Change the style to “Null”.

34. RC “New Parts Lists” > Add part
family…

35. Let’s assign the sewerage
manholes as shown.

Click “OK”.

36. RC “Concentric Cylindrical
Structure SI” > Add part size…

37. Verify the values > OK.

38. Repeat Steps 36 and 37 to generate another type of manhole shown below:
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39. Assign the style to be “Sanitary Sewer Manhole” as shown.

40. RC “Cylindrical Structure Slab Top Circular Frame SI” > Add part size…

41. Set the “Inner Structure
Diameter” to “450mm”.

Click “OK”.

42. Change the style to “Cleanout”.

43. Finally, set the rules as shown.

44. Click “OK” to complete the Parts List dialog and save the drawing to filename “32 Pipes-
Exercise1_METRIC.dwg”.
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7.2 Creating a Sanitary Sewer/Sewerage/Drainage/Stormwater Gravity Network

Once we have determine the Part Lists and Pipe Rules for a project, we are now ready to design, edit, and
annotate a complete gravitational pipe network system.

There are several ways to create gravitational pipe networks. You can do so by using the Civil 3D pipe Network
Layout Tools. You can also create gravitational pipe networks from AutoCAD objects such as lines and
polylines. Or, use any existing Civil 3D objects such as alignments and feature lines.

This exercise will give you hands-on experience using the Civil 3D Network Layout Tools method.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “32 Pipes-Exercise1_METRIC.dwg”.

2. Expand the Surfaces branch in
Prospector.

This drawing has several surfaces
which have a “_No Display” style
applied to simplify the drawing.
The surface you will be working
off is a composite of the existing
conditions, corridor surfaces, and
grading surfaces.

3. Notice that there are several road
alignments too.

4. Home tab > Pipe Network > Pipe Network Creation Tools.
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5. Complete the dialog as below:
 Network name = Sanitary

Sewer Network
 Part list = Sanitary Sewer
 Surface = Composite
 Alignment = Cabernet_Court
 Structure label style = Data

with Connected Pipes
(Sanitary)

 Pipe label style = Length
Description and Slope.

Click “OK”.

6. Select the Structure and Pipe as shown.

7. Activate “Node” OSNAP.

8. Run the “Pipes and Structures”
command as highlighted.

9. Click the “X” at point 1 and “X” at
point 2 as shown.

10. Change the pipe to “250mm”.
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11. Place the Structures at “X”s labelled 3, 4 and 5. Hit “ENTER” keyboard to complete the command.

12. Let’s clean-up the labels by using the label grip to drag the label off to the side.

13. Change the pipe back to
“200mm”.

14. Run the “Pipes and Structures”
command again.

15. Connect the “X” label 6 to label 2.
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16. In the Prospector tab, browse to
the Sanitary Sewer Network list.

When you click the “Pipe”, the
preview pane will list the pipes
that you have modelled
previously.

If you click “Structures”, the
preview pane lists the manholes
information.

17. Close the model withOUT saving.

Generally, you may want to try
converting AutoCAD polyline into Civil
3D Pipe Network as shown.

The “Create Pipe Network From
Object” command creates a Pipe for
every linear segment of the polyline and
places a Structure at every vertex.

This option is useful for long-single run
pipe network. It can’t build branching
networks or append objects to this
network. However, once many pipe
networks exist in the same model, you
can merge them together using “Merge
Networks” command.

7.3 Editing Gravity Pipe Network

This exercise will give you hands-on experience in making a variety of edits to a gravitational flow of Sanitary
Sewer and gravitational flow of Stormwater Drainage systems.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename “33 EditingPipesPlan_METRIC.dwg ”.
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2. Select the structure STM STR 3
icon in the drawing.

3. Run the “Swap Part” command.

4. Let’s change the catch basin to
“1,000x750mm” size.

Click “OK”.

5. A new icon is placed to represent
catch basin.

6. Use AutoCAD Erase command to delete structure SAN STR 7.

BEFORE AFTER

7. Select the sanitary sewer pipe at
the north of the drawing.



myCivil Plus 2016 : Intensive Training for Beginners Advanced Road, Water & Wastewater Module

8.  Click the cyan-colour
triangular grip.

 Hit the TAB keyboard.
 ENTER “60.96” to change the

length of the pipe.

Note:
The length is the effective 3D
length which include the
slope/gradient of the pipe.

9. Select any pipe in the drawing >
Edit Pipe Network

10.  Assign “SMH” structure list.
 Run the “Structure Only”

command.

11. Click at the end of the pipe line
that we have lengthened
previously.

Note:
There is a special peach-colour
grip telling you that a structure
will be attached to the end of this
pipe/line.

12. A brand new manhole has been
added to the end of the pipe.

13. Select the STM STR 3 catch basin
in the model.

14. Run the “Structure Properties”
command.
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15.  Goto “Part Properties” tab.
 Change the Sump Depth to

“0.000”.
 Click “OK”.

16. Goto Prospector tab, and browse
to the Structures list as shown.

You may rename the each
structure located in the preview
pane as highlighted.

17. Close the drawing without saving.

7.4 Creating an Alignment from Network Parts

On some occasions, certain legs of the pipe network require their own stationing/chainage. Perhaps most of
your pipes are shown on a road profile but the legs that run offsite or through open space require their own
profiles. Whatever the reason, it’s often necessary to create an alignment from network parts. The next
exercise will demonstrate this mission.
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No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename
“34 AlignmentFromNetworkParts_METRIC.dwg”.

2. Select the CB1 structure.

3. Select “Alignment from
Network” ribbon command.

4. Select the STM STR 7 structure >
ENTER keyboard.

5. Name your alignment “Storm
CL”.

Notice the “Create Profile and
Profile View” is activated.

Click “OK”.

6.  Select “Composite” surface.
 Click “Add”.
 Click “Draw In Profile View”.
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7. Jump to “Pipe/Pressure
Network” link.

8. Ensure “Storm Network” list is
activated.

9.  Ensure “Show only parts selected to draw in profile view” is actiavted.
 Click “Create Profile View”.
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10. Zoom out and click any empty
space in the model.

11. Close the drawing without saving.

7.5 Labelling Pipe Network Profile including Crossings

This exercise will meet the following objectives:
 Creating an alignment from a pipe network.
 Labelling the pipe networks in Profile View.
 Showing crossing pipe in the Profile View.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename
“35 Pipes-Excercise3_METRIC.dwg”.

2. Select the Sanitary Structure 16.

3. Select “Alignment from Network”
ribbon command.

4. Select Sanitary Structure 18 >
ENTER keyboard.
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5. Verify the highlighted values > OK

6.  Sample the “EG” and “Corridor FG” surfaces.
 Change the Style for “Corridor FG – Surface (2)” to “Design Profile”.
 Click “Draw in profile view” button.

7. Jump to “Pipe/Pressure Network”
link.
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8. Ensure “Yes” is selected for each
pipe and structure under Sanitary
Network.

9. Click “Create Profile View” button and place the Profile View to the right of the site plan.

10. Select EITHER one pipe or one
structure inside the profile view.

11. Run the “Entire Network Profile”
ribbon command.

12. The “STA:” and “OFF:” is missing
because the alignment was created
AFTER the pipe network.
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13. Prospector > Pipe Networks >
Networks > Sanitary Network >
Structures.

14. Select Structure 16, 17 and 18.

15. Scroll to the right until you see the
“Reference Alignment” header.

16. Right-click “Reference Alignment” >
Edit…

17. Choose “SMH16 To SMH18”
alignment > OK.

18. You may need to type REGEN ALL at the command line to see your updated structure labels.
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19. Our thrid objective of this exercise to to investigate the Crossing Pipe scenario. Pan your drawing until
you see the Storm layout located on Syrah Way.

The sanitary pipe network has already been laid out on the Syrah Way Profile. You want to show the
four storm pipes where they crosses the sanitary so you can adjust the pipe elevations, if necessary.

20. Select all four pipes that cross perpendicular to the Syrah Way alignment.

21. Run the “Draw Parts in Profile”
ribbon command.

22.  Pan to the Syrah Way Profile
View.

 Click the title of the Profile
View.

23. You should see four blue colour
crossing pipes in the Syrah Way
Profile.
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24.  Hit ESC keyboard.
 Select the Syrah Way Profile

View.
 Run the “Profile View

Properties” ribbon command.
25.  Goto “Pipe Networks” tab.

 Activate “Show only parts
drawn in profile view”.

26. Change the Crossing Pipes style as shown below:

27. Click OK. Now you can see clearly whether the crossing pipes require elevation adjustment or not.
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28. Adjust the levations of the crossing pipes as needed.

Close the drawing WITHOUT saving.

7.6 Pipe Network Interference Check

In Building Information Modeling (BIM), one of the main reason of adopting the BIM technology is to detect
any clashes of components within the project boundary. This feature is popularly known as Clash Detection.

In design, you must ensure pipes and structures have appropriate separation. The following exercise will lead
you through creating a pipe network and using Interference Check to scan your design for potential pipe
network conflicts.

No. Descriptions Commands/Remarks
1. Open the drawing. This drawing

includes a sanitary sewer pipe
network and a storm drainage
network.

Browse to filename
“36 Interference_METRIC.dwg”.

2. In the drawing, select ANY part
from either network.

In this example, we select one of
the crossing pipe (Storm drainage).

3. Run the “Create Interference
Check” ribbon command.
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4. Select the OTHER pipe network.

In this example, we will click at one
of the Sanitary Sewer structure.

5.  Verify the highlighted values.
 Click “3D proximity check

criteria…” button.

6. You’re interested in finding all
network parts that are within a
certain tolerance of one another. In
this exercise, we allow 0.5m
distance.

This setting creates a buffer to help
find parts in all directions that
might interfere. If you forget to
activate “Apply 3D Proximity
Check” option, you would only get
“direct” physical collisions among
pipe networks.

Click “OK” twice to run the
Intereference Check.
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7. A report is presented telling you
that there are three clashes have
been detected.

Just hit OK.

8. Goto Prospector and right-click
“Exercise” > Zoom to.

9. A small marker denotes where the
interference occurs.

10. Select any one of the interference marker, the pipes that intersect, and the nearby inlets.
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11. Run the “Object Viewer” ribbon
command.

12. You will clearly see the interference marker (sphere-shaped) telling you that 0.5m clearance distance. So
long as ANY pipes/structures touches this 0.5m spherical marker, they are considered as
clash/interference problem.

13. Close the Object Viewer mode.

Close the drawing WITHOUT saving.

7.7 Creating Pipe Tables

Preparing a clean construction drawing is a big challenge for infrastructure project. Would it be better to
replace those engineering parameters in a tabulation format? Let’s explore how to simplify the drawings using
Pipe Network Table feature.

No. Descriptions Commands/Remarks
1. Open the drawing. This drawing

includes a sanitary sewer pipe
network and a storm drainage
network.

Browse to filename
“35 Pipes-Excercise3_METRIC.dwg”.
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2. Goto “Annotate” > Add Tables >
Pipe Network > Add Structure.

3. Just hit “OK” to accept default
values.

4. Click any empty space in the drawing. The sample Structure table is shown below:

The table creation for pipes is similar to the structure table creation process.

5. Close the drawing WITHOUT
saving.
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CHAPTER 8 : PRESSEURISED PIPE NETWORKS

Since version 2013, AutoCAD Civil 3D has been enhanced with a brand new feature called pressure networks.
Pressure pipes work differently than gravity flow pipe systems within Civil 3D. Much of the need for custom
parts like valves or hydrants is eliminated with these systems.

8.1 Creating Pressure Network Parts List

In the following exercise, you will create a pressure network parts list for water supply system.

No. Descriptions Commands/Remarks
1. Open the drawing. This file is set up

with a layer state that makes other
objects grey. This will help you
focus on the placement of pressure
pipe networks objects.

Browse to filename
“37 Pressure_METRIC.dwg”.

2. Goto Home tab > Create Design >
Set Pressure Network Catalog.

3. Verify that the Catalog Database
File is set to
“Metric_AWWA_PushOn.sqlite”.

Flanged join type and Mechanical
join type are not supported in Civil
3D. However, the most commonly
used join type in modern water
supply construction is the push-on
type.
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4. Goto Settings tab > Pressure
Network > RC Parts Lists > New…

5. Rename the Pressure Network
Parts List to “Watermain”.

6. Pressure Pipes tab > RC New Parts
List > Add material…

7. Activate “ductile iron” > OK.

8. Right-click “ductile iron” > Add
size…

9. Verify the highlighted values > OK.
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10. Switch to “Fittings” tab > RC New
Parts List > Add type…

11. Activate all types of fittings > OK.

12. RC “ductile iron Elbow” > Add size…

13. Set the values as highlighted > OK.

14. Repeat steps 12 and 13 for 22.5o

and 45o bend angles elbow with the
same 250mm nominal diameter
and Allowable defection of 5o.

15. RC “ductile iron Tee” > Add size…
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16. Set the nominal diameter to
250mm > OK.

17. Switch to the Appurtenances tab >
RC New Parts List > Add type…

18. Activate the “gate valve-push on-
ductile iron-16 bar” > OK.

19. RC “gate valve-push on-ductile
iron-16 bar” > Add size…

20. Set the Nominal Diameter to
250mm > OK.

21. Click OK again to complete the creation of the Watermain pressure network parts list.

Close the drawing WITHOUT saving.

8.2 Modelling the Watermain Pressure Network

In this exercise, you will create a water supply pressurised network. Use the red-colour “X” markers in the
drawing as a guide for placement, but don’t worry if your pipe network is slightly off from the guides.
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No. Descriptions Commands/Remarks
1. Open the drawing. This file is set up

with a layer state that makes other
objects grey. This will help you
focus on the placement of pressure
pipe networks objects.

Browse to filename
“38 Watermain_METRIC.dwg”.

2. Home tab > Pipe Network >
Pressure Network Creation Tools.

3. Set all values as shown > OK.

4. Set the default cover to 1.500m.

5. Set the OSNAP to “Insertion” only.
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6. OSNAP at the first red-marker label
1 and click.

7. Place the first bend by clicking (or
OSNAP) near red-marker label 2.

8. At the bend, you are restricted to
the ALLOWABLE bending angles
listed in your part network. The
yellow-colour compass glyph that
appears represents the elbow
angles to the left and right of your
pipe. If you had not included
multiple elbow angles, only the
default elbow angle of 11.25o

would be available.

9. Turn off the OSNAP (i.e. press F3
keyboard).

10. Click the red-marker labelled 3 until
labelled number 8.

11. Hit ESC keyboard to terminate the
command.

12. Select pipe between label 7 & 8.
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13. Touch the cyan-colour diamond
glyph until you see the “Defection”
notation.

Click this diamond glyph.

14. Use the defection angles (yellow-
projected lines) to aim at the green
circle.

15. The pipe has been deflected to
target to the green circle.

16. Click the “+” cyan-colour glyph to
continue the layout.

17. Continue placing the elbow at X lael
9 and 10.

From this moment, the elbows may
not be placed exactly on the X-
marker anymore.

You can always use the glyphs to
re-position the pipe location after
the fact.
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18. Hit ESC to end the command.

19. Change the fitting to “Tee-
250mmx250mm”. Then, click “Add
Fitting” button.

20. As you hover the cursor near the
end of the pipe, you will see the
“Add Fitting” glyph as shown.

Just click to add the Tee
connection.

21. Hit ESC keyboard to end the
command.

22. Click the Tee > right-click >
“Disconnect from pressure part”.

23. The command line says “Select connected pressure part:”. Click the pipe before this Tee.
Now that the part is disconnected, you are free to rotate it into place.
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24. Select the Tee > click at the
“Rotation” cyan-colour glyph.

25. Enter “-90” at the Dynamic Input.

26. The Tee is now rotated to the
correct position, but it must be
reconnected back to the pipe.

27. Click the Tee > click the “Location”
glyph > move the Tee until you see
the connection glyph > click.

28. Select the Tee to reveal the grips >
click the “+” glyph (North) to
continue the layout.
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29. Place the Tees at marker label 11
and 12.

Hit ESC keyboard to end the task.

30. Repeat steps 28 and 29 but working
towards South marker.

31. Click the “Add Appurtenance”
ribbon command.

32. Place the valve at the end of both
North and South end pipes.

33. Close the drawing WITHOUT saving.
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8.3 Pressure Pipe Networks in Profile View

Pressure pipe networks can do things in profile view that gravity pipes cannot. With pressure pipes, the profile
view can be used to add on to the pipe layout, change straight pipes to curves, and delete parts from the
project altogether.

In the following exercise, you will draw the pressure pipe network in profile view and modify the layout using
the “Follow Surface” command.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename
“39 PressureProfile_METRIC.dwg”.

2. Modify tab > Design > Pressure Pipe
Network

3. Run “Alignment from Network”
ribbon command.

4. Click the icon of Gate Valve at the
far right of the drawing.

5. Click the southern part of the
project.



myCivil Plus 2016 : Intensive Training for Beginners Advanced Road, Water & Wastewater Module

6. Hit ENTER keyboard.

Verify the highlighted values > OK.

7.  Add the “Composite” surface.
 Click Draw in profile view.

8. Verify the Pipe/Pressure Network
lists as per highlighted > Create
Profile View.

9. Place the Profile View by entering
coordinate (700,000, 60,000).
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10. You should see the completed
profile view in the drawing.

Our next mission is to align the
pressure pipes to follow the
Composite/proposed surface
having 1.5m depth below this
surface.

11. Select ANY part in the Profile View.

12. Run the “Profile Layout Tools”
ribbon command.

13. Run the “Follow Surface”.

14. Click the both first and last pipe in
the Profile View > ENTER

15. Enter “1.5” for depth below
surface.
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16. The new Profile of the pressure
pipe network is displayed.

17. Close the drawing WITHOUT saving.

8.4 Design Checks

Pressure pipe networks differ from the gravitational pipe network when it comes to design check. Since the
fluid in a pressure network can go uphill, the rules you saw in gravity systems no longer apply. The main
concerns for a pressure system are pressure loss and depth of cover.

Bear in mind that Civil 3D is for modelling tool NOT analysis software. So, Civil 3D will NOT compute the
pressure loss at each junction, but you can set an acceptable range of values for pipe bends and radius of
curvature for curved pipes.

Design Check will check for improperly terminating pipes, mismatched pipe and fitting diameters, any curved
pipe whose radius has exceeded acceptable values, and pipes that have exceeded the maximum deflection you
set up in the parts list.

In the following exercise, you will modify command settings and run a depth check on the pressure pipe
network.

No. Descriptions Commands/Remarks
1. Open the drawing.

Browse to filename
“40 PressureDesignCheck_METRIC.dwg”.
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2. Goto Settings tab > Pressure
Network > Commands > RC
RunDepthCheck > Edit Command
Settings…

3. Verify the highlighted values > OK.

4. Select the far left pipe in the Profile
View.

5. Run the “Depth Check” ribbon
command.

6. Click the far left pipe, then far right
valve > ENTER keyboard.
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7. Verify the value > OK.

8. In both plan view and profile view,
warning will appear if any Depth
Check violations are found.

9. Hover over any of the warning, a
yellow tooltip box will elaborate
the details of the warning.

10. Close the drawing WITHOUT saving.

Disclaimer:
THE AUTHOR MAKES NO WARRANTY, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, REGARDING THESE
MATERIALS AND MAKES SUCH MATERIALS AVAILABLE SOLELY ON AN “AS-IS” BASIS.
IN NO EVENT SHALL THE AUTHOR BE LIABLE TO ANYONE FOR SPECIAL, COLLATERAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING OUT OF PURCHASE OR USE OF THESE
MATERIALS. THE SOLE AND EXCLUSIVE LIABILITY TO AUTODESK, INC., REGARDLESS OF THE FORM OF ACTION,
SHALL NOT EXCEED THE PURCHASE PRICE OF THE MATERIALS DESCRIBED HEREIN.
The Author reserves the right to revise and improve its products as it sees fit. This publication describes the
state of this product at the time of its publication, and may not reflect the product at all times in the future

Author’s Note : Should you find any errors or misleading information within this customized courseware,
please send your email to autobimnetwork@gmail.com.

Thank you.


